
A6V10424692_en--_a Building Technologies
2014-05-14 Control Products and Systems

Sinteso Test

Installation
Commissioning



Legal notice

2
Building Technologies A6V10424692_en--_a
Fire Safety 2014-05-14

Legal notice
Technical specifications and availability subject to change without notice.
© 2014 Copyright by Siemens Switzerland Ltd

Transmittal, reproduction, dissemination and/or editing of this document as well as
utilization of its contents and communication thereof to others without express
authorization are prohibited. Offenders will be held liable for payment of damages.
All rights created by patent grant or registration of a utility model or design patent
are reserved.

Issued by:
Siemens Switzerland Ltd.
Infrastructure & Cities Sector
Building Technologies Division
International Headquarters
Gubelstrasse 22
CH-6301 Zug
Tel. +41 41 724-2424
www.siemens.com/buildingtechnologies

Edition: 2014-05-14
Document ID: A6V10424692_en--_a



3
Building Technologies A6V10424692_en--_a
Fire Safety 2014-05-14

Table of contents

1 About this document ......................................................................................5
1.1 Applicable documents .......................................................................................6
1.2 Technical terms ................................................................................................7

2 Function ..........................................................................................................8

3 Setup ...............................................................................................................9
3.1 Accessories .................................................................................................... 12

3.1.1 Bluetooth extension kit FDUD29x-E ................................................. 12
3.1.2 Detector exchanger and tester FDUD292 ......................................... 12

4 Compatibility ................................................................................................. 13
4.1 Hardware........................................................................................................ 13
4.2 Software ......................................................................................................... 13
4.3 Mobile terminals ............................................................................................. 13

5 Installation .................................................................................................... 14

6 Commissioning ............................................................................................. 16
6.1 Loading configuration data in 'Sinteso Test' .................................................... 16

6.1.1 Exporting configuration data from SintesoWorks .............................. 16
6.1.2 Loading configuration data onto the mobile terminal ......................... 19
6.1.3 Importing configuration data into 'Sinteso Test' ................................. 20

6.2 Connecting the mobile terminal with the detector exchanger and tester ........... 20

7 Operation ...................................................................................................... 22
7.1 Opening data from the detection tree .............................................................. 22
7.2 Creating audio comments ............................................................................... 23

8 Remedying problems ................................................................................... 24

Index.............................................................................................................. 25



4
Building Technologies A6V10424692_en--_a
Fire Safety 2014-05-14



About this document 1
Applicable documents

5
Building Technologies A6V10424692_en--_a
Fire Safety 2014-05-14

1 About this document
Overview
'Sinteso Test' simplifies the process of comparing the data stored in the detection
tree with the device information for installed peripheral devices.
'Sinteso Test' is installed on a mobile terminal – for example, a smartphone – and
used alongside an FDUD292 detector exchanger and tester and an FDUD29x-
E Bluetooth extension kit.
The detector exchanger and tester FDUD292 with Bluetooth extension
kit FDUD29x-E installed sends the 'Serial no. ("ID-Nr.")' of an installed peripheral
device to 'Sinteso Test'. 'Sinteso Test' displays the data assigned to the 'Serial no.
("ID-Nr.")' in the detection tree. The detector exchanger and tester allows you to
query the device information for the installed peripheral device and compare this
with data from the detection tree.

Goal and purpose
This document contains the information you will need to install and commission the
'Sinteso Test' version 1.x.

Document identification
The document ID is structured as follows:
A6Vxxxxxxxx_aaAA_vv
A6Vxxxxxxxx_--AA_vv
A6Vxxxxxxxx_aa--_vv
A6Vxxxxxxxx_----_vv

ID coding1 Description

A6Vxxxxxxxx STEP-ID generated by the STEP system

_ Separator

aa Language abbreviation in accordance with ISO 639-1

AA Country abbreviation in accordance with ISO-3166-1

-- Multilingual or international

vv Document version, single or double digit: a, b, …z; aa, ab, …az; ba,
bb, …bz; etc.

1 Some documents have different ID codes that are generated by an earlier system.
There are also documents with up-to-date ID codes along with additional features
in the designation.

ID code Examples

ID_languageCOUNTRY_version
-- = multilingual or international

A6V10215123_deDE_a
A6V10215123_en--_a
A6V10315123_----_a

Date format
The date format in the document corresponds to the recommendation of
international standard ISO 8601 (format YYYY-MM-DD).
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Conventions for text marking
Markups
Special markups are shown in this document as follows:

Requirement for a behavior instruction

1.
2.

Behavior instruction with at least two operation sequences

      – Version, option, or detailed information for a behavior instruction

      Intermediate result of a behavior instruction

End result of a behavior instruction

Numbered lists and behavior instructions with an operation
sequence

[  X] Reference to a page number

'Text' Quotation, reproduced identically

<Key> Identification of keys

Supplementary information and tips

The 'i' symbol identifies supplementary information and tips for an easier way of
working.

Open-source software (OSS) licenses
You will find the license texts for the open-source software embedded in the
product in document A6V10432127. See the chapter 'Applicable documents [  6]'.

1.1 Applicable documents
Document ID Title

007227 Technical manual Detector exchanger and tester FDUD292

009078 FS20 Fire detection system - Configuration

A6V10405496 Installation Bluetooth extension kit FDUD29x-E

A6V10432127 Open-Source Software (OSS) Licenses Sinteso Test
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1.2 Technical terms
Term Explanation

A2DP Abbreviation for 'Advanced Audio Distribution Profile'.
Technology for sending stereo audio signals to a receiving
device via Bluetooth

BDV Abbreviation for 'Basis Data Variant'

Serial no. ("ID-Nr.") Unique serial number of the device (see no. labelled with "ID-
Nr." on the device sticker)

TTS Abbreviation for 'Text-to-Speech'



2 Function

8
Building Technologies A6V10424692_en--_a
Fire Safety 2014-05-14

2 Function
If you successfully execute one of the commands listed below using a detector
exchanger and tester FDUD292 on a peripheral device, the detector exchanger
and tester transfers the 'Serial no. ("ID-Nr.")' of the peripheral device to the mobile
terminal via the Bluetooth extension kit FDUD29x-E. 'Sinteso Test' displays the
data assigned to the 'Serial no. ("ID-Nr.")' in the detection tree that has been
transferred. The peripheral device is marked as having been tested in 'Sinteso
Test'.
Detector exchanger and tester commands for opening the detailed view in 'Sinteso
Test':

 '2.4 ALARM'
 '2.5 Test Alarm'
 '2.2 Check + ALARM'
 '2.3 Check+Testalarm'
 '2.6 Test Alarm Total'
 '2.7 Chk+Test Al. Tot.'

Functional scope
 Displaying detection tree and data stored within it.
 Displaying total number of peripheral devices, number of those tested, and

number of those not tested.
 Displaying and/or reading out the data stored in the detection tree for an

installed peripheral device.
 Entering or dictating comments on a peripheral device.
 Saving and restoring comments and lists of tested devices.
 Searching for a character string in a detection tree.
 Using filters to adapt the display on the peripheral devices.
 Importing an XML file with configuration data.
 Displaying information on the system that has been saved.
 Adapting 'Sinteso Test' settings.

Settings
 Establishing which peripheral device data is displayed.
 Establishing which peripheral device data is read.
 Switching voice output on and off.
 Setting the sound level.
 Selecting the detector exchanger and tester for the connection.
 Changing 'Sinteso Test' language.
 Switching 'Sinteso Test' Bluetooth function on and off.
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3 Setup
View of the detection tree

View of the detection tree

Item Name Function

1 Connection status Displaying the status of the connection between the mobile terminal and the
Bluetooth extension kit.

2 'Search' Searching for a character string in the detection tree.

3 'Settings' Adapting preferences.

4 'filter' Selecting filters for displaying peripheral devices.
 'filter untested': Untested peripheral devices are displayed.
 'filter tested': Tested peripheral devices are displayed.
 'filter marked': Peripheral devices with comments are displayed.
 'show all': All peripheral devices are displayed.

5 Level Level to which the displayed elements belong.

6 Element  Elements for the selected detection tree level
 Buttons for switching to the next level down.

7 'A' 1 Number of all peripheral devices in an element

8 'T' 1 Number of tested peripheral devices in an element

9 'U' 1 Number of untested peripheral devices in an element

10 Group number Group number. Only displayed if the group number display is switched on.

1 The abbreviations depend on the language in use and may differ from the English
screenshot.
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View of the settings

View of the settings

Name Function

'Bluetooth' Switching 'Sinteso Test' Bluetooth function on and off.

'Tester Selection' Selecting the detector exchanger and tester.

'Import XML file' Importing an XML file with configuration data.

'Import STR file' Importing an STR file with saved comments and a list of the tested peripheral
devices.

'Save' Exporting comments and a list of the tested peripheral devices in an STR file.

The STR file can be opened in Excel as an XML file.

'Activate / deactivate
display or speech output'

Setting which information is displayed and/or read in the detailed view of a
peripheral device.

'Group' Switching the group number display on and off.

Can only be selected if the country-specific message layout uses the 'Plan no.'.

'Order for filtered devices' Selecting the criteria to be used for sorting search results.

'Sound volume' Setting the sound level.

'Change language' Changing the display and audio output language.

'Debug' Displaying data sent by the detector exchanger and tester to 'Sinteso Test'.

'Display site information' Displaying 'Site Name', 'Site Number', and 'Date of last download'.

'Date of last download' is the date on which the configuration data was exported
from the fire control panel.

'Application version' Displaying the 'Sinteso Test' version.
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Detailed view
The detailed view displays the data from the detection tree that is assigned to a
peripheral device.

Detailed view of a tested peripheral device

Item Function

1 Data from the detection tree

2 Displays whether or not the peripheral device has been tested

3 Pauses or continues the voice output

4 Plays comments back

5 Records comments

6 Deletes the recorded comments

7 Text field for entering comments
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3.1 Accessories

3.1.1 Bluetooth extension kit FDUD29x-E
 For connecting the detector exchanger and tester

FDUD292 to a mobile terminal
 Enables wireless data exchange between a

detector exchanger and tester and a mobile
terminal

 Compatible with:
– Detector exchanger and tester FDUD292

 For details, see document A6V10405496
 Order no.: S54319-Z30-A1

3.1.2 Detector exchanger and tester FDUD292
 For testing, configuring, and setting parameters for

compatible devices as well as inserting and
removing point detectors.

 Compatible with:
– Adapter cable FDUD292-A
– Telescope rod FDUM291
– Telescope rod FDUM292
– MCL-USB adapter FDUZ221
– MCL-USB (radio) adapter FDUZ227
– Bluetooth extension kit FDUD29x-E
– Sinteso Test

 For details, see document 007227
 Order no.: A5Q00003357
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4 Compatibility

4.1 Hardware
Peripheral devices
'Sinteso Test' is compatible with Sinteso™ FDnet devices that are displayed in the
detection tree and also with the detector exchanger and tester FDUD292.

Service devices
'Sinteso Test' is compatible with a detector exchanger and tester FDUD292. The
detector exchanger and tester must meet the following conditions:

 The Bluetooth extension kit FDUD29x-E is installed.
 Firmware version 3.1 or higher is installed.

Fire control panels
'Sinteso Test' is compatible with Sinteso fire control panels with firmware and BDV
versions from market package 3 or higher.

4.2 Software
SintesoWorks
SintesoWorks FXS2002 version from market package 5.2 or higher.

4.3 Mobile terminals
Operating system
'Sinteso Test' is compatible with Android 4.x.

Mobile terminals
'Sinteso Test' has been tested with the following mobile terminals:

 Samsung Galaxy S3 (Android 4.0.4)
 Samsung Galaxy S4 (Android 4.3)
 Samsung SIII Mini GT-I8190 (Android 4.1.2)
 Samsung Galaxy Note 2 (Android 4.1.2)
 HTC One (Android 4.3)

Headphones
'Sinteso Test' is compatible with the following headphones:

 Wired headphones
 Bluetooth headsets with A2DP protocol

'Sinteso Test' has been tested with the following Bluetooth headsets:
 Plantronics Voyager Legend
 Plantronics Marque 2
 Jabra Supreme
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5 Installation
'Sinteso Test' is available from the Siemens App Store. Use the 'Mobile@Work'
app to access the Siemens App Store.

 The mobile terminal is registered at 'saa.siemens.com'. You will find more
information at 'http://saa.siemens.com'.
If necessary, enter the approving authority's e-mail address in the 'Approver
Email' field.

 The 'Mobile@Work' app is installed and set up on the mobile terminal. You will
find more information at
'https://intranet.w1.siemens.com/cms/saa/information/Documents/android_SAA
_Installation_Guide.pdf'.

 The mobile terminal is connected to the Internet.

1. Open 'Mobile@Work'.

 A list of available app stores is displayed.

2. Press 'In-House Apps' (1).

 A list of available apps is displayed.

3. Press 'Sinteso Test'.

 Information about ''Sinteso Test' is downloaded and displayed.

4. Press 'Download' (1).

 'Sinteso Test' is downloaded.
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5. Press 'Install' (1).

 The required authorizations are displayed.

6. To accept the authorizations, press 'Next' (1).

7. To install 'Sinteso Test', press 'Install'.

 Sinteso Test is installed.

8. Press 'Open'.

 'Sinteso Test' opens and the detection tree is displayed.

 'Sinteso Test' creates a 'Sinteso Test' folder on the internal memory card.
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6 Commissioning
Prerequisites

 The Bluetooth extension kit FDUD29x-E is installed in the detector exchanger
and tester. You will find more information on installing the Bluetooth extension
kit in document A6V10405496.

 Firmware version 3.1 or higher is installed on the detector exchanger and
tester. You will find more information on updating the firmware in
documents 007227 and 009078.

 'Sinteso Test' is installed on the mobile terminal. You will find more information
in chapter 'Installation [  14]'.

See also
 Applicable documents [  6]

6.1 Loading configuration data in 'Sinteso Test'

6.1.1 Exporting configuration data from SintesoWorks
You must export the configuration data from SintesoWorks to an XML file. You
must use the correct style sheet for the export so that the XML file can be imported
into 'Sinteso Test'. The export is divided into the following two sections:

 Check the version of the 'SpeedTesting_x.x.x.xsl' style sheet.
 Export the configuration data to an XML file.

Checking the version of the 'SpeedTesting_x.x.x.xsl' style sheet
 SintesoWorks FXS2002 version MP5.2 or higher is installed on the PC.

1. Click on the 'Help' > 'View additional documents' menu item.

 The 'Additional_Documents' folder is shown in the 'Windows Explorer'
software.

2. Enter the word SpeedTesting in the 'Search' text field and press <Enter>.

 The search results are shown in 'Windows Explorer'.

3. Check whether the 'SpeedTesting_x.x.x.xsl' style sheet has exporterVersion 8
or higher. You can tell if the version is correct from the file designation (e.g.
SpeedTesting_0.0.8.xsl) or in the XSL or XML file by looking at the following
line (for example): <SiteExport exporterVersion="0.0.8" mdVersion="0.0.3">

- If the 'SpeedTesting_x.x.x.xsl' style sheet has exporterVersion 7 or lower
contact your localization manager.

- If the 'SpeedTesting_x.x.x.xsl' style sheet has exporterVersion 8 or higher,
you can export the configuration data.
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Exporting configuration data to an XML file
 SintesoWorks FXS2002 version MP5.2 or higher is installed on the PC.

 The configuration for a system with firmware version MP3 or higher is loaded in
SintesoWorks. You will find more information in document 009078.

 There is a 'SpeedTesting_x.x.x.xsl' style sheet with exporterVersion 8 or higher
saved on the computer.

1. Open a Site using the 'File' > 'New site' or 'Open' menu item.

2. Click on the 'File' > 'Site export (XML)' menu item.

 The 'Site XML export' window opens.

'Site XML export' window

3. Check the 'Create custom XML export' checkbox.

4. The maximum number of 'Stations' that can be loaded is limited. If the
configuration of the Site exceeds the limit, you must select the 'Stations' for the
export. To do this, activate the corresponding checkbox.
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5. Select 'Use file from file system'.

User-defined XML export

6. Click on 'Browse' and enter the path to the 'SpeedTesting_x.x.x.xsl' file.

7. Click on 'Report: create export'.

 The configuration for the Site is exported into an XML file that is compatible
with 'Sinteso Test'.
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6.1.2 Loading configuration data onto the mobile terminal
 A 'Sinteso Test' folder has been created on the internal memory card.

1. Connect the mobile terminal to the PC using a USB cable.

2. Copy the XML file with the configuration data into the 'Sinteso Test' folder (2) in
the main directory for the internal memory card (1).

 The configuration data is stored on the mobile terminal.

Example 'Sinteso Test' folder in the file manager
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6.1.3 Importing configuration data into 'Sinteso Test'
 The XML file with the configuration data is saved in the 'Sinteso Test' folder.

1. Start 'Sinteso Test'.

2. Click on .
 The 'Settings' screen is displayed.

3. Click on 'Import XML file'.

 The available XML files are displayed.

4. Click on the required XML file.

 'Sinteso Test' imports the configuration data.

 The 'Area' level is displayed in the detection tree view.

6.2 Connecting the mobile terminal with the detector
exchanger and tester
Preparing the detector exchanger and tester

 The Bluetooth extension kit is installed in the detector exchanger and tester.
You will find more information in document A6V10405496.

 Firmware version 3.1 or higher is installed on the detector exchanger and
tester. You will find more information in document 007227.

1. Switch the detector exchanger and tester on.

2. If the  symbol is not shown on the display, execute command '8.2 Enable'.
 Menu point '8.2 Disable' and the  symbol are shown on the display.

3. Execute the '8.1 Make visible' command.

 The text 'Device is visible as FDUD29x-XX:XX:XX' is shown on the display.

1 The last 6 numbers of the MAC number for the Bluetooth extension kit.

 The Bluetooth extension kit is switched on and visible to other devices.
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Connecting the mobile terminal with the detector exchanger and
tester

The detector exchanger and tester is switched on and the  symbol is shown
on the display.

 The Bluetooth extension kit is visible to other devices.

1. Switch on the Bluetooth function on the mobile terminal.

2. Start searching for other visible Bluetooth devices from the mobile terminal.

 The mobile terminal searches for visible Bluetooth devices.
 A list of visible Bluetooth devices is displayed on the mobile terminal.

3. Select the required 'FDUD29x-XX:XX:XX' in the list.

4. Open 'Sinteso Test'.

5. Click on .
 The 'Settings' view is displayed.

6. Click on 'Bluetooth' (1).

 The 'Sinteso Test' Bluetooth function is switched on.

7. Click on 'Tester Selection' (2).

 The visible Bluetooth devices are displayed.

8. Click on 'FDUD29x'.

 'Sinteso Test' establishes a connection to the Bluetooth extension kit.

9. Press the 'Back' button on your mobile terminal.

 'Connected' (1) is displayed in the status line in detection tree view.

Section view of the detection tree once the connection has been established

10. Click on  on the detector exchanger and tester.

 The  symbol is shown on the detector exchanger and tester display.

 The detector exchanger and tester is not visible to Bluetooth devices with
which a connection has not previously been established.
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7 Operation

7.1 Opening data from the detection tree
The data stored in the XML file is displayed by 'Sinteso Test' and the peripheral
device is marked as having been tested if the detector exchanger and
tester FDUD292 successfully executes one of the following commands:

 '2.4 ALARM'
 '2.5 Test Alarm'
 '2.2 Check + ALARM'
 '2.3 Check+Testalarm'
 '2.6 Test Alarm Total'
 '2.7 Chk+Test Al. Tot.'

You will find more information on how to execute the commands in document
007227.

Opening data from the detection tree
 The detector exchanger and tester is connected with 'Sinteso Test'.

 The system's XML file is imported into 'Sinteso Test'.

 Using the detector exchanger and tester, execute one of the commands listed
above.

 If the command is executed successfully, 'Sinteso Test' marks the peripheral
device as 'Tested'.

 If the command is executed successfully, 'Sinteso Test' displays the detailed
view with data from the detection tree.

 If the voice output is activated, the data is read from the detection tree.

If wired headphones are connected, you can use these to restart the voice output
of the data.
To restart the voice output, press the control button on the cable.

See also
 Applicable documents [  6]
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7.2 Creating audio comments

Starting a recording overwrites an existing recording for the displayed peripheral
device.

 'Sinteso Test' displays the detailed view with data from the detection tree.

1. To record an audio comment, click on  and speak into the mobile terminal.
 The  symbol is displayed.

2. To end the recording, click on .
 The recording ends and the  symbol is displayed.

3. To play the recording, click on .
4. To delete the recording, click on .
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8 Remedying problems
Problem Solution

The 'SpeedTesting.xslt' style sheet cannot be found
when exporting the XML file from SintesoWorks.

Select 'Help' > 'View additional documents' in
SintesoWorks.

Enter the path listed here into the Export dialog.

The connection to the Bluetooth extension kit is not re-
established when opening 'Sinteso Test'.

 Switch Bluetooth off and on again on the mobile
terminal.

 Switch mobile terminal off and on again.

Test the charge state of the battery for the detector
exchanger and tester and insert a new one if
necessary.

The mobile terminal displays the following message
on opening the detailed view: 'Your device does not
have the necessary software installed to read in the
selected language. Do you want to install it from the
play store?'.

Install a file containing the language data for the 'Text-
to-Speech output' function for your mobile terminal.

The text in the detailed view is too large. Reduce the text size in the system settings for the
mobile terminal.

The voice output is difficult to understand. Reduce the speed of the voice output in the system
settings for the mobile terminal.

Strings of capital letters are spelled out individually
rather than read as a word.

Deactivate the 'Sound volume'.checkbox under 'Spell
all-capital words' in the Settings view.

The Bluetooth extension kit symbol is not displayed. Check whether the Bluetooth extension kit is switched
on and, if necessary, perform command '8.2 Enable'.

Switch the service device off and on again.

Check whether the 10-pin connector for the Bluetooth
extension kit has been disconnected and, if
necessary, reconnect it. See document A6V10405496.

See also
 Applicable documents [  6]
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